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Abstract  

This paper explores various options to visualize tourism transport flows with spatial analysis 
tools and show them on maps. To facilitate implementation of these options, procedures for 
data preparation and map creation are explained through a set of practical instructions. This 
can give guidance to tourism researchers who are looking for effective ways to map flow 
data with geographical information systems. Special attention is paid to free and open 
source software as high costs of commercial software often limit opportunities to study 
these data. All procedures have been developed and tested using a database of interactions 
between world regions and some samples of results are shown.  

Keywords: flow map, origin-destination table, intra-regional flows, inter-regional flows 

Introduction 

Flow maps are a mix of maps and flow charts showing movements of objects from one 
location to another (Phan et al. 2005). Objects may be persons, goods or information. In 
tourism, examples of such movements are trips by tourists form one country to another or 
visitor flows in national parks. Researchers studying such movements may wish to visualize 
them in maps to provide insight into movement patterns, thereby contributing to a better 
understanding of movement patterns and processes. A good example is the analysis of 
tourist flows in New Zealand undertaken by Forer (2000). Flow maps also allow exploration 
of the relationship between flows and other parameters, such as population density. Flow 
maps strongly enhance insight in the distribution of flows in an area. International tourist 
flow patterns, especially with regard to air traffic, are critically analyzed in view of their 
substantial contribution to greenhouse gas emission. These patterns can be investigated on 
national as well as global scales using arrival and departure data, and estimates can be 
made of emissions. Becken (2002) used national arrival data to obtain emission figures in 
order to discuss their increase against the background of sustainable tourist development. 
More recently, a study on a global scale was undertaken by Peeters and Landré (2012) to 
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indicate causes and consequences of carbon dioxide emission growth and then evaluate 
policies to mitigate these environmental impacts of tourism. This paper explores methods 
for the creation of flow maps and gives detailed instructions to do this. Using a global 
tourism and transport database (GTTD) of the year 2005, methods had to be found to 
visualize information on tourist movements within and between world regions by means of 
flow maps. Much effort went into the selection of suitable software and mapping 
procedures. In this paper, we want to share our experiences with exploring suitable options 
to visualize tourism transport flows on a world map. 

First we explain the distinction between visual analysis tools and spatial analysis tools and 
give examples of both. Next we give a short description of the GTTD. The remainder is used 
to show in a very practical way how we used a number of spatial analysis tools to visualize 
tourist transport flows, thereby making a distinction between the preparation of flow data 
and their actual mapping. We start by explaining how tourism flow maps can be created 
with ArcMap, a well-known commercial desktop GIS. We then move to Flowpy, which as an 
independent tool improves the flow mapping functionality of GIS software in general. Finally 
we show how we used Flowmap, a complete spatial analysis toolbox oriented at analyzing 
networks, to fulfill specific requirements with regard to mapping internal flows. We also 
show how some necessary GIS commands are implemented with QGIS, a very popular free 
and open source desktop GIS. 

Visual analysis versus spatial analysis tools 

With regard to flow representation, a distinction has to be made between visual analysis 
tools and spatial analysis tools. The latter tools use data which have a geographical 
reference. They can therefore become part of or linked to geographical information systems 
(GIS). The former do not have that reference and belong to computer graphics. 

We did not test visual analysis tools that create flow maps. However, we had a look at Flow 
Map, (not to be confused with Flowmap) developed by a group of researchers of Stanford 
University’s Computer Science Department’s Stanford Visualization Group) and  jFlowMap, 
recently developed at by a group of researchers of the University of Fribourg and the 
University of Konstanz (http://graphics.stanford.edu/~dphan/code/flowmap). Both are Java 
based visual exploration tools that offer very sophisticated views. 
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Figure 1. World tourism regions 

They have, unfortunately, limited export functionality. Views in Flow Map can only be 
exported in purely graphical formats such as jpg or eps (Phan at al. 2005). Those in 
jFlowMap can only be saved in scalable vector graphics (svg) format (Boyandin et al. 2011). 
To create a link with GIS software is cumbersome, which is unfortunate as these tools allow 
extensive visual exploration, such as highlighting flows and nodes and making selections on 
the basis of magnitude and length, very useful capabilities in flow analysis. 

With regard to spatial analysis tools, desktop GIS like ArcMap or QGIS can do analysis and 
visualization of spatial data very well, but miss sufficient functionality to handle flows 
properly as origin and destination points have to be connected by desire lines (straight lines, 
indicating Euclidian distance, between origins and destination points) showing the 
magnitude of flows. Fortunately, a number of extensions have been developed for that 
purpose, which, however, require extensive additional data processing and are only 
available in commercial software. Partly for this reason, a number of flow mapping software 
packages have appeared on the market available as freeware. We have tested the following 
options, including commercial software as well as freeware: 

• ArcMap with a number of tools from ArcToolbox. ArcMap is the main component of 
ArcGIS, ESRI’s suite of commercial geospatial processing software 
(http://www.esri.com). ArcToolbox is another component. 

• Flowpy using ArcMap or QGIS for input and output. Flowpy is a Python script written 
by Alan Glennon of the University of California Santa Barbara in 2009 
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(http://www.enj.com/software). QGIS is a popular GIS freeware package 
(http://qgis.org). 

• Flowmap (not the same as Flow Map mentioned earlier) using ArcMap or QGIS for 
input and output. Flowmap, originally developed by Tom de Jong at the Faculty of 
Geographical Sciences of Utrecht University in 1990 for use in developing countries. 
Over the years, it has been substantially extended with additional functionality and is 
now a comprehensive spatial interaction software package 
(http://flowmap.geog.uu.nl). 

The global tourism and transport database (GTTD) 

The GTTD contains international and domestic trips for 12,568 origin-destination links 
between and within 221 countries. Each record describes number of trips, average one-way 
distance between origin and destination, total return distance travelled, and direction of 
trips. For example, Austria-Belgium and Belgium-Austria are distinct records. Furthermore, 
the database contains data about total population, GDP per capita and the area of each 
country (Peeters & Landré 2012). Main sources and methods to build the GTTD are: 

• international tourist arrival data per country of origin from the World Tourism 
Organisation (UNWTO 2007), resulting in 12,118 international flows 

• domestic tourist trips per country, based on the relationship between number of 
trips and GDP per capita 

• domestic average distance, based on the relationship between country area and 
known domestic tourist trip distance averages per EU country (Peeters et al. 2007) 

• 15 largest domestic flows redistributed over distance classes, with averages of 200, 
400, 600 and up to 6,000 km one-way (Peeters and Landré 2012) 

• international distances added by calculating the great circle (shortest) distances 
using Great Circle Mapper (http://gc.kls2.com) and the main entry airports of 
countries 

The GTTD’s total number of trips compares well with the figures published by the World 
Tourism Organisation (UNWTO), which are 3% higher for international trips and 1% higher 
for all trips (UNWTO-UNEP-WMO 2008). The part of the GTTD used to create tourism flow 
maps, inter-regional, i.e. between world regions (see figure 1), as well as intra-regional, i.e. 
within regions, consists of an origin-destination (OD) Excel table with columns of origins, 
destinations, number of trips and average distance (Peeters and Landré 2012). 

http://www.enj.com/software�
http://flowmap.geog.uu.nl/�
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Creating tourism flow maps with ArcMap 

It is possible to create flow maps with ArcMap with the help of some tools from ArcToolbox. 
One can decide to split the OD table in two parts, one for intra-regional flows and one for 
inter-regional flows, or not. It is recommended to split the table. The flow map then 
distinguishes between inter-regional trips represented by graduated symbols and intra-
regional trips represented by proportional symbols. This is visually more attractive. 

 Data preparation 

The original OD Excel table was saved in dbf format, after which an attribute selection was 
done on the OD dbf table, where origin equals destination, to create two new tables, one 
for intra-regional trips and one for inter-regional trips (see table 1). One also needs a point 
shapefile with the locations of the centroids of the tourism regions. In ArcMap, centroids 
can easily be extracted from the polygon region file using the Feature to Point tool in 
ArcToolbox.  

Table 1. Sample of OD table of inter-regional trips (see figure 1 for region codes) 

Origin 
Code 

Destination 
Code Trips 

Average 
Distance 

2 9 15,156,781 6,004 
9 15 6,308,508 9,845 
9 2 9,686,593 5,853 
2 3 29,544,096 1,672 
17 2 3,883,906 10,854 
9 12 16,480,662 2,533 
2 14 3,362,006 11,719 
9 10 27,357,425 1,313 
16 9 2,118,354 16,778 
9 3 4,666,475 7,504 
9 4 3,688,043 9,297 
2 15 2,390,411 14,257 
9 14 3,816,463 8,386 
17 9 3,277,735 9,496 
9 16 1,582,391 16,719 
14 15 7,957,459 3,304 
9 5 10,410,679 2,311 
15 14 6,319,096 3,384 
9 8 2,072,999 8,831 
14 9 2,113,690 8,228 
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Map creation 

First the table with the intra-regional trips is joined to the point shape file of region 
centroids using region code and origin code as common fields. It is advised to make the join 
permanent by exporting it as a new shapefile and delete unnecessary fields. The layer of this 
file can now be used to add symbology. 

To make a file in order to use its layer to add symbology for the inter-regional flows is more 
complicated. The following procedure applies: 

1. If not done yet, add columns for the x and y coordinates of points to the point 
shapefile of region centroids using the Add XY Coordinates tool in ArcToolbox. 

2. Join the point shapefile to the table of inter-regional trips using origin code and 
region code as common field. Make the join permanent by exporting all records as a 
new dbf file. Then remove the join. 

3. Join the point shapefile to the table of inter-regional trips using destination code and 
region code as common field. Make this join permanent. Do not forget to remove 
the join. 

4. Join the file created in step 3 to the file created in step 2 using OID as common field. 
Make this join also permanent. 

5. Create polylines using the XY to Line tool. The output is a polyline shapefile of all 
inter-regional flows with their magnitude. As the Robinson projection was used, the 
polylines will be bent. 

6. Join the table of interregional trips to the polyline shapefile using FID and OID as 
common field and export all features as a new shapefile. This step adds the flow 
magnitudes to the polyline shapefile (see table 2). 

By selecting attributes, selections can now be made to set limits to the flow magnitudes, 
excluding all flows not fulfilling them. Figure 2, for example, shows all flows larger than one 
million.  
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Figure 2. Two-way inter-regional flows; intra-regional flows 

 

Table 2. Sample of OD table with coordinates of interregional trips 
X Coord 
Origin 

Y Coord 
Destination 

Y Coord 
Origin 

Y Coord 
Destination Origin Destination Trips 

Average 
Distance 

-9,096,143 4,695,478 644,386 5,644,578 2 9 15,156,781 6,004 
644,386 5,644,578 10,298,277 847,935 9 15 6,308,508 9,845 
644,386 5,644,578 -9,096,143 4,695,478 9 2 9,686,593 5,853 
-9,096,143 4,695,478 -8,958,626 2,308,280 2 3 29,544,096 1,672 
12,123,293 4,008,124 -9,096,143 4,695,478 17 2 3,883,906 10,854 
644,386 5,644,578 4,209,397 3,107,806 9 12 16,480,662 2,533 
-9,096,143 4,695,478 9,098,104 4,041,301 2 14 3,362,006 11,719 
644,386 5,644,578 1,723,994 5,042,911 9 10 27,357,425 1,313 
12,454,420 -2,690,707 644,386 5,644,578 16 9 2,118,354 16,778 
644,386 5,644,578 -8,958,626 2,308,280 9 3 4,666,475 7,504 
644,386 5,644,578 -5,604,082 -1,564,097 9 4 3,688,043 9,297 
-9,096,143 4,695,478 10,298,277 847,935 2 15 2,390,411 14,257 
644,386 5,644,578 9,098,104 4,041,301 9 14 3,816,463 8,386 
12,123,293 4,008,124 644,386 5,644,578 17 9 3,277,735 9,496 
644,386 5,644,578 12,454,420 -2,690,707 9 16 1,582,391 16,719 
9,098,104 4,041,301 10,298,,277 847,935 14 15 7,957,459 3,304 
644,386 5,644,578 953,687 2,970,772 9 5 10,410,679 2,311 
10298277 847935 9098104 4041301 15 14 6319096 3384 
644386 5644578 2405059 -1905800 9 8 2072999 8831 
9098104 4041301 644386 5644578 14 9 2113690 8228 
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Creating tourism flow maps with Flowpy 

Flowpy was intended to replace Data Model Tools (FDMT), an ArcMap application 
developed by Glennon in 2005. It is an adaptation of Tobler’s Flow Mapper, built within the 
framework of the Geographic Initiatives Project by a group of researchers from the 
University of California Santa Barbara, University of Oklahoma and University of Utah 
(Glennon and Goodchild 2005). FDMT as ArcMap application could only function on specific 
versions of this software. Therefore, Glennon reprogrammed it as a Python script, 
functioning independently. We have used this script to visualize the flows related to the 
database. It generates a polyline shapefile, which can be added as a layer in a desktop GIS to 
create symbology and eventually a flow map. Flowpy can only be used after additional 
installing Python 2.6, GDAL and Python/GDAL bindings. The procedure to do this is fast and 
well-explained in the software instructions. 

Data preparation 

For this option, the original OD Excel table has to be transformed to a square matrix using 
Data > PivotTable and PivotChart Report (see Annex 1 for procedure). The only task left is 
that all the blank cells in the square matrix must be converted to zero (see Annex 2 for 
procedure).  

The worksheet is now ready for conversion to space delimited text (see table 3). To create 
sufficient space between columns, column width has to be set to a suitable number of 
digits. Save then as Formatted Text (Space Delimited). If conversion does not succeed 
because of a size limit set by the software, one can open the worksheet in Access and then 
save from there as space delimited text. A second data file needed for the second option is a 
file (see table 4) containing the point coordinates of the origins (see Annex 3 for procedure). 

Table 3. Sample of input interaction file (origins in rows and destinations in columns) 

 1 2 3 4 5 6 7 
1 45,477,126 14,862,000 2,042,426 263,753 111,005 38,059 40,836 
2 14,406,441 628,606,910 29,544,096 1987,258 298,322 119,192 149,761 
3 331,269 14,496,093 91,627,354 423,547 23,986 57,010 421 
4 128,567 1,820,239 1,006,825 215,145,633 48,914 31,768 1,828 
5 23,660 44,003 110,948 635 69405,844 145,547 2,680 
6 12,726 92,520 334,533 14,078 130,990 119,103,001 7,407 
7 8,642 28,247 8,260 207 154,764 129,590 72,916,314 
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Table 4. Coordinates of origins and destinations (world regions) 

Region Code X Coordinate Y Coordinate 
Canada 1 -7,352,159 6,271,812 
Central America 3 -8,958,626 2,308,279 
East Asia 14 9,098,104 4,041,300 
Eastern Africa 7 3,409,844 705,380 
Eastern Europe 10 1,723,993 5,042,911 
Former USSR 11 6,623,286 6,096,767 
Greenland 18 -2,671,327 7,574,787 
Japan 17 12,123,293 4,008,123 
Middle East 12 4,209,397 3,107,805 
Northern Africa 5 953,686 2,970,772 
Oceania 16 12,454,420 -2,690,707 
OECD Europe 9 644,385 5,644,577 
South America 4 -5,604,082 -1,564,097 
South Asia 13 6,995,799 2,735,142 
South East Asia 15 10,298,277 847,935 
Southern Africa 8 2,405,058 -1,905,799 
USA 2 -9,096,143 4,695,478 
Western Africa 6 811,329 1,023,886 

 

Map creation 

The script written by Glennon uses a square interaction matrix and corresponding 
coordinate pairs of the nodes to calculate three flow types: two-way flow, i.e. a one-
directional flow together with a reverse-directional flow, gross flow, i.e. the sum of a one-
directional flow and a reverse-directional flow, and net flow, i.e. the difference between a 
one-directional flow and a reverse-directional flow. It needs two script files as well as two 
space-delimited text files, namely an input point file and an input interaction file. The names 
of the two data files and the paths to them must be indicated in the interface as well as the 
type of flow calculation needed, and the name of and path to the output shapefile. 

The original spreadsheet of flow data contains an interaction matrix that can be separated 
in three parts: a left diagonal containing the intra-regional flows, a lower subtriangle 
containing the inter-regional one-directional flows and an upper subtriangle containing the 
inter-regional reverse-directional flows. This separation can be implemented using the Excel 
add-on BigMatrix.xla, called Linear Algebra for Big Matrices, developed by Volpi of Foxes 
Team (http:/digilander.libero.it/foxes). 
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Figure 3. Component of square interaction matrix 

Three new spreadsheets are created in this way, one for each component of the original 
interaction matrix, which are then saved as text files for use as input in Flowpy. This script is 
then able to create shapefiles for different flow types: two-way flows, one-directional flows, 
reverse-directional flows, intra-regional flows, gross flows and net flows. Initially, two-way, 
gross and net flows include intra-regional flows if they are part of the interaction matrix. To 
exclude the latter flows, the lower subtriangle must be added to the upper subtriangle and 
then saved as a text file. 

 

Figure 4. One-directional and reverse directional inter-regional flows; intra-regional flows 

After the shapefiles have been added as layers in a desktop GIS, symbology can be added 
with ArcMap or QGIS to visualize the flows. Figure 4 shows a map created with ArcMap, 
visualizing the inter-regional flows in two directions by making both of them transparent.  
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Creating tourism flow maps with Flowmap 

Flowmap has a multitude of spatial analysis functions. As it specializes in the display, 
analysis and modelling of spatial interaction (De Jong and Van der Vaart 2010), it can also 
display flow data using straight lines or wedges.  

Data preparation 

For the option of using Flowmap to visualize flows, at least two files must be created (if 
origins and destinations are the same), namely a file named ???????1.dbf for the locations 
of origins and destinations and a file named ???????2.dbf for the magnitude of flows. The 
structure of the point file is label – xcoordinate – ycoordinate, and that of the flow file is 
score – label1 – label2. Label1 is the flow origin and label2 the flow destination. Both labels 
must appear in the origin and destination files. Point files can be derived from the point 
shapefiles with columns for the x and y coordinates (created with ArcMap or QGIS), whereas 
for flow files the original OD table is used by changing the order of the columns and 
removing the column of the average distance. 

Map creation 

In Flowmap, one has to create a project first. In each new project, an origin file, destination 
file (they can be the same) and flow file must be specified. These files are in dbf format. The 
origin and destination files contain the coordinates of origin and destination points 
respectively, whereas the flow file contains the magnitude of each flow or desire line, a 
reference to its origin and a reference to its destination. A great advantage of Flowmap is 
that it can handle very large datasets. It also has an extensive flow symbology, part of which 
can be exported. Unfortunately, Flowmap does not take intra-regional flows into account. 

To show he difference in map quality between Flowmap and ArcMap, the largest 
international flows of Dutch holiday makers, with the countries of destination showing total 
distance travelled, were visualized with Flowmap (see figure 5) as well as with ArcMap (see 
figure 6), created with ArcMap. The destination countries are colour coded as based on total 
transport volume of Dutch tourists in passenger kilometers. Flowmap also has certain 
disadvantages. Figure 6 shows that the range of colouring in Flowmap is very limited 
compared to that of ArcMap. Flowmap also builds its symbology in a linear procedure, 
making editing more complicated. If it is necessary to make changes, one has to start a new 
procedure. Furthermore, Flowmap can only save a map in jpg and bmp graphics formats and 
the resolution of such maps is limited (De Jong and Van der Vaart 2010). 

The above-mentioned shortcomings of Flowmap can be removed by developing a procedure 
to create intra-regional flows and using the output of Flowmap as input in a desktop GIS for 
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visualization purposes. This procedure also allowed us to create added value by making 
these flows comparable with inter-regional flows. 

 

Figure 5. Largest international flows of Dutch holiday makers visualized with Flowmap 

 

Figure 6. Largest international flows of Dutch holiday makers visualzed with Arcmap (source: 
Peeters and Landré 2012) 

The procedure to create intra-regional flows in Flowmap is as follows: 

1. Differentiate  between origin file and destination file 

2. Change the codes by adding O in origin file and D in destination file 

3. Add a field and adapt the coordinates using the equation dC = (√/4)*AVDIST*100 
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4. Deduct dC in the origin file from x and y coordinates for all records 

5. Add dC in the destination file to x and y coordinates for all records 

6. Replace the original coordinates with these new coordinates 

7. Create a project in Flowmap by specifying, origin file, destination file, flow file and 
flow export file 

8. Use wedges and customize flow symbology by making the arrow shaft proportional 
and by setting the width 

9. Display flows on a map by drawing desire lines from the flow file 

The export file, created by Flowmap in bna format, can be converted to mif (MapInfo 
Interchange) format. One can then use the MIFToShape tool in ArcToolbox to convert this 
file to a shapefile. Alternatively, this mif file can be added in QGIS as a vector layer and 
saved as a shapefile. The intra-regional flows can now be visualized with a desktop GIS 
(see figure 7). They are shown in opposite directions, from SW to NE and from NE to SW, 
to indicate that such flows, like inter-regional flows, have an origin and destinations at 
different locations, although inside the region. To get these flows into the opposite 
direction, origin and destination files must be switched in Flowmap. Flow magnitude is, 
similar to inter-regional flows, indicated by the width of wedges. A great advantage of this 
procedure is that distances of intra-regional flows can be shown by their length using 
average distance as an indicator. 

 

Figure 7. Two-way inter-regional and intra-regional flows between world regions (source: 
Peeters and Landré 2012) 
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Having spatial and attribute data in a desktop GIS at this stage, makes it easy to undertake 
what-if scenarios. Figure 8, for example, shows the same flows as in figure 7, but with trips 
with distances larger than 6,000 km proportionally redistributed to departures per country 
over all trips shorter than 6,000 km, thus keeping total number of trips constant, while at 
the same time reducing total distances covered. The latter is important with respect to 
reducing tourism’s contribution to climate change (Peeters and Dubois 2010). 

 

Figure 8. Two-way inter-regional and intra-regional flows between world regions limiting 
the distance of inter-regional trips to 6,000 km (source: Peeters and Landré 2012) 

Conclusions 

Researchers in the field of tourism and transport might benefit from the visualization of 
tourism flows. Without such visualization it is more difficult to really comprehend the 
distribution of tourism flows, to easily find possible relationships with other spatial 
information and to determine the significance of some flow. Visualization is first of all 
valuable to generate hypotheses about how the tourism system works and how it is related 
to other spatial parameters. But it also helps to show the extent of tourism. For example, in 
studies on the role of tourism for developing countries, simple flow maps would show easily 
this role to be very small (see figure 7). Furthermore, flow maps are invaluable for 
education, giving a memorable imprint of the situation in one clear figure, while showing 
tables with long ranges of numbers will not stick very long to the reader’s memory. The 
value of GIS software in this regard is still underestimated due to lack of information about 
its functionality and a perception that it is too technical for use in the tourism field. The 
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main purpose of this paper is to empower tourism researchers who lack the necessary skills 
to map flows on the basis of spatial data and allow them to visualize flow patterns using 
various methods. Flow maps can provide much added value to origin-destination tables and 
can show more insight in changes in flow patterns. Our advice is strongly founded on our 
experiences in recent research (Peeters and Landré 2012). Unfortunately, there are no 
straightforward procedures to create flows on the basis of an OD table. Various software 
products are available that support the necessary additional tasks. We have indicated three 
options that do not require any programming skills. To use one of these options, one has to 
prepare the data input exactly as prescribed by the software.  

ArcMap provides extensive facilities to create flow maps and does not need external tools. 
Its freeware alternative, QGIS, cannot create desire lines from points, but has excellent data 
processing and mapping functions that rival those of ArcMap. Flowpy and Flowmap extend 
the functionality of GIS desktop software for handling flows. Therefore, it is recommended 
to create flow maps with QGIS using them as external tools.  

There are also different ways to handle flows. One can differentiate between intra-regional 
and interregional flows and use different types of symbology. One can also differentiate 
between two-way flows, gross flows, net flows, one-directional flows and reverse-
directional flows. There are also various options to visualize intra-regional flows. 
Furthermore, flows (the width of the symbols showing the flows) have been shown here to 
represent the number of trips, but can also easily be used to show number of passenger-
kilometers travelled or total amount of CO2 emissions as well as economic parameters like 
flows of revenues. The space for creativity is large and much depends on the purpose of the 
mapping process and the conditions set for visualizing flows. 
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Annex 1: Procedure for transformation of OD Exel table to a square matrix 

1. Using the wizard, in step 1, select Microsoft Office Excel list or database and select 
PivotTable, then click Next. 

2. In step 2, indicate the data range and click Next. 

3. In step 3, select New worksheet and click Finish.  

4. Drop Origin items in section Drop Row Fields Here, drop Destination items in Drop 
Column Fields Here and drop Sum of Trips in section Drop Data Items Here. 

5. Copy the trip data without the row and column totals and paste them to a new 
worksheet. 

Annex 2: Procedure of conversion of blank cells in a square matrix to zero 

1. Select the cells with trip data 

2. Click Edit and then Go To 

3. Click Special  
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4. Select Blanks and then click OK. All blank cells have now been selected. 

5. Click Edit again and then Replace 

6. Enter 0 in the Replace with box and click Replace All 

7. All former blank cells now contain zeros. Click OK 

Annex 3: Procedure for the creation of a file containing point coordinates of origin 

1. In ArcMap, find the centroids of the regions using the Feature to Point tool (in QGIS, 
use Vector > Geometry Tools > Polygon centroids). 

2. Add the coordinates of these centroids to the data file using the Add XY Coordinates 
tool (in QGIS, use Vector > Geometry Tools > Export/Add geometry columns). 

3. In Excel, open this file in dbf format, copy the coordinates to a new worksheet and 
set the width of the columns with Format > Column > Width). 

4. Save this worksheet as Formatted Text (Space Delimited). 
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